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About this document

Scope and purpose

This user guide provides an overview of the evaluation board EVAL-M1-IM323 including its main features, key
data, pin assignments, and mechanical dimensions.

This evaluation board has been developed to provide initial support to customers in designing motor drive
applications for major home appliances such as air conditioners, pumps, fans, and other variable-speed drives.

The EVAL-M1-IM323 is part of the IMOTION™ modular application design kit (MADK). Together with a control
board equipped with the M1 20-pin interface connector, such as the EVAL-M1-101T, it features and
demonstrates the Infineon CIPOS™ Tiny intelligent power module (IPM) technology and advanced motion
control engine (MCE 2.0) technology for permanent magnet motor drives. EVAL-M1-IM323 is based on the
IM323-L6Gx CIPOS™ Tiny IPM. The IM323-L6Gx is designed to control 3-phase AC motors and permanent
magnet motors in variable-speed drives. It works with a voltage of 600 V and provides a current rating of 15 A.

Intended audience

This user guide is intended for all technical specialists who know motor control and low-power electronic
converters. The evaluation board is intended to be used under laboratory conditions.

Evaluation Board

This evaluation board is to be used during the design-in process for evaluating and measuring characteristic
curves, and for checking datasheet specifications.

Note: PCB and auxiliary circuits are NOT optimized for final customer design.

Figurel TheiMotion™ MADK evaluation board for IM323-L6Gx CIPOS™ Tiny IPM

Please read the Important Notice and Warnings at the end of this document Revision 1.0
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Important notice

“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board
(PCB) for demonstration and/or evaluation purposes, which include, without limitation, demonstration,
reference and evaluation boards, kits and design (collectively referred to as “Reference Board”).

Environmental conditions have been considered in the design of the Evaluation Boards and Reference
Boards provided by Infineon Technologies. The design of the Evaluation Boards and Reference Boards
has been tested by Infineon Technologies only as described in this document. The design is not qualified
in terms of safety requirements, manufacturing and operation over the entire operating temperature
range or lifetime.

The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional
testing only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the
same procedures as regular products regarding returned material analysis (RMA), process change
notification (PCN) and product discontinuation (PD).

Evaluation Boards and Reference Boards are not commercialized products, and are solely intended for
evaluation and testing purposes. In particular, they shall not be used for reliability testing or production.
The Evaluation Boards and Reference Boards may therefore not comply with CE or similar standards
(including but not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other
requirements of the country in which they are operated by the customer. The customer shall ensure that
all Evaluation Boards and Reference Boards will be handled in a way which is compliant with the relevant
requirements and standards of the country in which they are operated.

The Evaluation Boards and Reference Boards as well as the information provided in this document are
addressed only to qualified and skilled technical staff, for laboratory usage, and shall be used and
managed according to the terms and conditions set forth in this document and in other related
documentation supplied with the respective Evaluation Board or Reference Board.

Itis the responsibility of the customer’s technical departments to evaluate the suitability of the
Evaluation Boards and Reference Boards for the intended application, and to evaluate the completeness
and correctness of the information provided in this document with respect to such application.

The customer is obliged to ensure that the use of the Evaluation Boards and Reference Boards does not
cause any harm to persons or third party property.

The Evaluation Boards and Reference Boards and any information in this document is provided "as is"
and Infineon Technologies disclaims any warranties, express or implied, including but not limited to
warranties of non-infringement of third party rights and implied warranties of fitness for any purpose, or
for merchantability.

Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation
Boards and Reference Boards and/or from any information provided in this document. The customer is
obliged to defend, indemnify and hold Infineon Technologies harmless from and against any claims or
damages arising out of or resulting from any use thereof.

Infineon Technologies reserves the right to modify this document and/or any information provided
herein at any time without further notice.
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Safety precautions

Note: Please note the following warnings regarding the hazards associated with development systems.

Table1 Safety precautions

Warning: The DC link potential of this board is up to 400 Voc. When measuring voltage
waveforms by oscilloscope, high voltage differential probes must be used. Failure to do
so may result in personal injury or death.

Warning: The evaluation or reference board contains DC bus capacitors which take
time to discharge after removal of the main supply. Before working on the drive
system, wait five minutes for capacitors to discharge to safe voltage levels. Failure to
do so may result in personal injury or death. Darkened display LEDs are not an
indication that capacitors have discharged to safe voltage levels.

Warning: The evaluation or reference board is connected to the grid input during
testing. Hence, high-voltage differential probes must be used when measuring voltage
waveforms by oscilloscope. Failure to do so may result in personal injury or death.
Darkened display LEDs are not an indication that capacitors have discharged to safe
voltage levels.

Warning: Remove or disconnect power from the drive before you disconnect or
reconnect wires, or perform maintenance work. Wait five minutes after removing
power to discharge the bus capacitors. Do not attempt to service the drive until the bus
capacitors have discharged to zero. Failure to do so may result in personal injury or
death.

Caution: The heat sink and device surfaces of the evaluation or reference board may
become hot during testing. Hence, necessary precautions are required while handling
the board. Failure to comply may cause injury.

Caution: Only personnel familiar with the drive, power electronics and associated
machinery should plan, install, commission and subsequently service the system.
Failure to comply may result in personal injury and/or equipment damage.

Caution: The evaluation or reference board contains parts and assemblies sensitive to
electrostatic discharge (ESD). Electrostatic control precautions are required when
installing, testing, servicing or repairing the assembly. Component damage may result
if ESD control procedures are not followed. If you are not familiar with electrostatic
control procedures, refer to the applicable ESD protection handbooks and guidelines.

Caution: A drive that is incorrectly applied or installed can lead to component damage
or reduction in product lifetime. Wiring or application errors such as undersizing the
motor, supplying an incorrect or inadequate AC supply, or excessive ambient
temperatures may result in system malfunction.

Caution: The evaluation or reference board is shipped with packing materials that
need to be removed prior to installation. Failure to remove all packing materials that
are unnecessary for system installation may result in overheating or abnormal
operating conditions.

>R B B BB
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1 The board at a glance

The EVAL-M1-IM323 evaluation power board is part of the IMOTION™ modular application design kit for motor
drives (iIMOTION™ MADK). The MADK platform is intended to be used with various power stages and different
control boards. The EVAL-M1-IM323 can be easily connected to a control board such as the EVAL-M1-101T
through the 20-pin IMOTION™ MADK M1 connector. The EVAL-M1-101T control board is designed to control a
single motor.

The EVAL-M1-IM323 is available through regular Infineon distribution partners and through Infineon’s website.
This user guide details the features of the evaluation board (Section 1.3) and provides information on how
customers can copy, modify, and qualify the design for production according to their specific requirements.

Environmental conditions were considered in the design of the EVAL-M1-IM323, but the evaluation board is not
qualified, in terms of safety requirements, for manufacturing and operation over the entire operating
temperature range or lifetime. The boards provided by Infineon are subjected to functional testing only.

The evaluation boards are not subject to the same procedures as regular products regarding returned material
analysis (RMA), process change notification (PCN), and product discontinuation (PD). Evaluation boards are
intended to be used under laboratory conditions by technical specialists only.

1.1 Scope of supply

The EVAL-M1-IM323 evaluation board is designed to provide an easy-to-use power stage based on Infineon’s
CIPOS™ Tiny intelligent power module (IPM) IM323-L6Gx.

The delivery includes the finished evaluation board as shown in Figure 1. It provides a single-phase AC-input
connector, an EMI filter, an input rectifier, DC bus capacitors, and a 3-phase output to connect the motor. It also
contains:

e A CooISET™ based auxiliary power supply to provide output of 15Vand 3.3V
e Emitter shunts for current sensing and overcurrent protection
e Avoltage divider for DC-link voltage measurement

The evaluation board shown in Figure 1 can be operated directly with the required power supply without
additional components.

1.2 Block diagram

The block diagram of the EVAL-M1-IM323 board is shown in Figure 2.

5 Revision 1.0
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CIPOS ™ Tiny IPM - IM323

EMI

AC in-rush

input

circuit

Figure2 Block diagram of the EVAL-M1-IM323 evaluation board

Figure 3 shows the top-side functional groups of the EVAL-M1-IM323 board.

Legend:
1. 220 Vac and PE input
connector

2. Inrush current limiter and
fuse

EMI filter
Auxiliary power supply
DC link

iMOTION™ MADK M1
connector (20-pin)

7. Fandrive circuit

8. CIPOS™ Tiny IM323-L6Gx
9. Heatsink with fan

10. Motor output connector

o o bk~ w

Figure3  Top-side functional groups of the EVAL-M1-IM323 evaluation design

Figure 4 shows the bottom-side design of the EVAL-M1-IM323 board.
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Figure 4 Evaluation design of the EVAL-M1-IM323, bottom-side

1.3 Main features

The EVAL-M1-IM323 evaluation board, combined in a kit, with one of the available MADK control boards has the
following features:

e Inputvoltage 165 Vac to 265 Vac

e Maximum 12 Ainput current at 165 Vac

e Maximum 1500 W motor power output at 220 Vac

e Inrush current limiter for circuit protection

e On-board EMI filter and pass EMI standards EN55032

e Auxiliary power supply with 15V,3.3V

e Overcurrent hardware protection and over temperature protection
e Sensing of DC-link voltage

e Thermistor output

e Temperature controlled cooling fan speed adjustment

e PCBsizeis 180 mm x 140 mm, two layers with 1 oz. copper
e RoHS compliant

14 Board parameters and technical data

Table 2 lists the important specifications of the EVAL-M1-IM323.

Table 2 Parameters
Parameter Symbol Conditions Value Unit
Input
Input voltage Vac Lower AC input, less motor power output | 165-265 | Vims

7 Revision 1.0
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Parameter Symbol Conditions Value Unit

Input current Iac(max1) Input 265 Vac, fowm=6 kHz, To=29°C, 8.72 Arms
Tc =90°C, with heat sink

Iacimax2) Input 165 Vac, fowm=6 kHz, To=29°C, 12.59 Arms

Tc=90°C, with heat sink

Output

Power (3-phase) Poutimax) Input 165 Vac, fowm = 6 kHz, To=29°C, 1400 w
Tc=90°C, with heat sink

Current per leg lout(max) Input 165 Vac, fewm =6 kHz, TA=29°C, 7.788 Arms
Tc =90°C, with heat sink

DC bus

Maximum DC-bus Voc(max) AC input 265 Vims 355 \

voltage

Minimum DC-bus Voc(min) AC input 165 Vims 208 v

voltage

Current feedback

Shunt resistance RS1,RS2,RS3 | Legshunt 30 mQ

8 Revision 1.0
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Parameter Symbol Conditions Value Unit
Protections
Overcurrent protection | loce Configured by changing shunt resistors 21.5° Apeak

RS1, RS2, and RS3 for current sensing

Auxiliary power supply

Voltage circuit (VCC) Vee Used for IPM power supply 15+5% v
voltage output

VCC current output lvee Used for IPM power supply 100 mA

3.3Vvoltage output Vssv Used for IMC101T controller and 3.3+2% Y
protection circuits

3.3V current output l33v Used for IMC101T controller and 200 mA
protection circuits

PCB characteristics

Dimension Length x width 180x140 | Mm

Material FR4, 1.6 mm thickness, 1 oz. PCB

System environment

Ambient temperature Ta 29 °C

1 For iMOTION™ IC IMCxxx, there are three types of gatekill input source options in the MCEWizard setup: gatekill-pin, comparator, and
both. If you select the “comparator” mode, the external gatekill signal will not be used, and the signals ly+/Iv+/lw+ will be compared by
the internal comparator with the “Device overcurrent trigger level setting” value set in the MCEWizard.
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2 System and functional description

2.1 Getting started

To run the motor system, a combination of IMOTION™ MADK power board (EVAL-M1-IM323) and a matching
MADK control board (EVAL-M1-101T or other control board) is required. This chapter provides information on
setting up the system and getting started with the IMOTION™ MADK development platform.

EVAL-M1-IM323 evaluation boards are tested with EVAL-M1-101T control boards that are shipped with
embedded firmware and default parameters.

Note: If you use the EVAL-M1-101T board as a controller, remove resistor R2 (4.7 k) from this evaluation
board. The EVAL-M1-IM323 evaluation board contains a pull-up resistor R21 with the
recommended 18 k. This improves the temperature behavior of the IM323-L6GX.

The following actions must be performed to achieve a usable motor controller IC from a blank IMC101T:

e Programming the motion control engine (MCE)

e Programming the parameter sets for system and motor

e Programming customer scripts (optional)

e Programming the combined file for an integrated system (optional)

The iIMOTION™ software tools—MCEDesigner and MCEWizard—are required for initial system setup, and to

control and fine-tune the system performance to match the user’s exact needs. These tools can be downloaded
from the Infineon website. Please visit this page periodically to check for tools and software updates.

An iMOTION™ link or an on-board USB-to-UART cable is needed to bridge the PC/debugger side and the motor
drive system (on the target iIMOTION™ device, hot side) with a 1 kV DC galvanic isolation.

Figure 5 shows the basic system connection using the EVAL-M1-IM323 board to run a 3000 W GK6081-6AC31
motor with MCEDesigner. Refer to the MCEWizard and MCEDesigner documentation for more information.

EMI test ground

AC input

Control board

UVW phase
output

Figure 5 Example of the system connection
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g MCEWizard 2.3.0.1 - CA\Users\mliuT\Documentst My work\2D2TWEVAL-M3-IM32\EVAL-MT-IM323 test\Debugge-Legs., — X

File JumptoPage Help

Welcome Fage -
iMOTION™ 2.0 System Configuration Wizard

Using System Configuration File: 5 \ e
EVAL-M1-IM323.mc2 . [nfineon )
b

This motor control system is an
evaluation kit for complete inverter-

controlled moter drive applications
based on EVAL-M1-101T iMOTION
MADK controler board (based an
IMC101T-T038 iIMOTION controller)
and EVAL-M1-IM323 MADK inverter
board {based on IM323-L6G CIPOS
Tiny IPM).

Following two options are available.  — |
Tf no hardware change is done on this
board and there is no plan to change
default control settings:

Select > Default Hardware and Control
Sattings.

Get MADK Hardware Info Get IMOTION™ Infa

Previous Next

Figure6 MCEWizard’s welcome page

After downloading and installing the MCEWizard and MCEDesigner, follow these steps to run the motor:

1.

Connect the EVAL-M1-101T control board to the EVAL-M1-IM323 evaluation board. Then, connect the PC-
USB connector to the EVAL-M1-101T control board.

Connect the 220 V AC power supply and the UVW outputs to the motor.
In the MCEWizard, enter the system and operating parameters of the target motor, and the hardware

parameters of the evaluation board. This data is used for calculating the digital parameter set of the
controller, representing the complete motor drive system.

After setting the system and operating parameters, go to the Verify & Save page and click Calculate
Parameters. If no errors are reported, save the drive parameter set into your project directory by clicking
Export to MCEDesigner file (.txt) (see Figure 7); if an error message appears, double-click the error
message (highlighted in RED) and adjust the erroneous parameters. This drive-system parameter file is later
used by the MCEDesigner (step 9.)

Note: Refer to the MCEWizard_V2.3.0.0 User Guide.pdf for details. This guide is available in the MCE

Wizard’s installation path.
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5’;; MCEWizard 2.3.0.1 - C:\Users\mliul\Documents\My work\ 202 Th\EVAL-M3-IM32ZNEVAL-MT-IM323 test\Debugge-Legs... =5 x

File JumptoPage Help

Verify & Save Page -

Verify Parameters

Calculate Parameters Display Parameters Results Export to MCEDesigner File (.bd)

Double-Click an item to JUMP to its associated question

Information #1 : Firmware Version

Firmware Version is v1.03.5x [For(.x), means any min version betwean .0 to ,9]
Information #2 ; System DC Bus Feedback Scaling

The DC Bus Feedback Scaling is 8.20 counts/Volt and max measurable voltage is 499.54V
Information #3 ; Motor 1 Current Feedback Scaling

The Motor Current Feedback Scaling is 93.09 counts/Apk and range is -22.00 to +22.00 Apk

#4 : System Config Options

->MCE Device OverCurrent Level: 21.5

->Motor Current Sensing Range -22.00 to +22.00 Apk

->Current Feadhack Typa: Leg Shunt

->Angle Feedback: Flux PLL Angle

~>Motor Control Mode: Speed Control

->Application Control Input; UART

Frevious Next

Figure7 MCEWizard’s Verify & Save page

5. Turnonthe 220V AC power supply, LED 1 and 2 turn red.

6. Startthe MCEDesigner tool and click File > Open to open the MCEDesigner default configuration file (.irc) for
the IMC101T device (IMC101T_Vxxx.irc.)

(The IMC101T_Vxxx.irc file is included in the downloaded IMC101T MCE software package.)

7. The MCEDesigner should automatically connect to the EVAL-M1-101T board using the default COM port
(indicated by a green circle next to the “COMx Up” status in the bottom frame of the MCEDesigner GUI). If
the connection cannot be established due to an incorrect COM port, change the COM port by following
these steps:

a) Open the System Page window.
b) Click Preferences > Connection > Connect using.
c) Choose one of the other available COM ports from the drop-down list.

8. Incase of a blank IC: If the firmware has been erased from the IMC101T, a warning message will pop up (see
Figure 8)—“Target device firmware and parameters files are not programmed! Please program firmware and
parameters file.” See step 9 on how to obtain/program firmware and parameters.

MCEDesigner >

target device firmare and parameters files are not programmed!
! . Please program firmare and parameters files.

Figure8 MCEDesigner warning message

9. Incase of a blank IC: To program the firmware and the parameters file into the internal Flash memory of the
iMOTION™ Control IC, follow these steps:

a) Open the System Page.
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b) Click Tools > Programmer and select Program Firmware and Parameters, as shown in Figure 9.

The encrypted firmware is available in the IMC101T MCE Software Package. For the parameters file,
browse and select the .txt file generated in step 4.

If the IMC101T IC is blank, the MCEDesigner will generate a pop-up message—“Target device firmware
and parameter files are not programmed!”

¢) Program the MCE firmware and system parameters into the internal Flash memory of the IMOTION™ IC
by selecting Tools > Programmer from the pull-down menu, and then selecting the Program Firmware
and Parameter check box.

d) Select the right parameter file and firmware file.
e) Click Start to program the firmware and parameter.
f) Click YES and then OK to update the IRC file with the parameter file.

g) Click Save As to save the IRC file with a file name that contains the COM config, parameters, and
firmware file path information.

Note: Refer to the MCEDesigner User Guide.pdf and the MCEDesigner_V2.3.0.0 Application Guide.pdf
(available in MCEDesigner’s install path) for details.

After the programming is complete, the red LED1 on EVAL-M1-101T will flash on.

Program IMC controller ?

X

Infarmation
DLL Wersion: v1.03.01 Release Time: 2019-11-26 Connection Paort: COM308

Operation Options

(" Program Parameters & Program Firmware and Parameters  © Program Script & Program Combined File

File:

Frogram Parameter File |QIEIEE Erowse..

Frogram Firmware File |C:\User5\m|\u1\Documents\iMOTIONE.D\\MCT MT-TOIRMCIOIT-TO3E_A N Browse..

Program Script File |

Wil

Frogram Combined File |

Start Cancel |

Figure9 MCEDesigner’s program page

10. Double-click the VF Diagnostic function in the motorl page and monitor the motor current with an
oscilloscope. If the motor current is not sinusoidal, change the target speed and Vd_Ext in VF Diagnostic
sub-function, then double-click VF Diagnostic again. Repeat until the oscilloscope shows a steady
sinusoidal current with an amplitude that is 30-50% of the motor rate current.

11. Open System Page > Monitor Definitions and double-click 1, & I,_Slow. The motor current feedback should
be clean and sinusoidal, as shown in Figure 10. If not, please tune the Gating Propagation Delay & Phase
Shift Window Size in the MCEWizard. The sampled motor-current noise amplitude should be less than 50-
100 counts (below 5% of the motor current or below 5% of the maximum AD (Analog to Digital converter)
range, which is 2048 counts.) If not, the motor current sample-related hardware and the setup need tuning.
The VF Diagnostic sub-function can verify whether the:

o Motoris correctly connected
o IGBT/MOS and gate driver work as expected

o Parameters related to current-sensing are correctly configured
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o PCBlayout and DC bus decoupling has been done correctly

12. After the VF Diagnostic is complete, click STOP (the red traffic light button) to stop the PWM (Pulse Width
Modulation).

| B8 Trace Results

lu & hv_Fast

T e e e e
100 150 . 280 300 350
Sample Rate: 16kHz /(20 * 1 ) with Auto Repest on Level Mode
Cursor Control Axis Control in R Scale Offset Grid
b3 o = )0 ) /500
7’ s
Chl On, < )326.000 ‘31000 Chly Z2)-1000 y 1000 1 jo Chl On
c:.am "_'_ 300.000 =) -2.000 Ch2Yy ',Amun ) 1000 1 J (i} Ch2 Off
Apply AppL R? sat. |
Auto Repaat

Figure10 Trace waveform for I, &I, open loop diagnostic

13. Click the green traffic light button in the control bar to start the motor or double-click Start Motor sub-
function in the Motorl page - group of User Application Function Definitions; motor runs when the above
step functions properly.

14. Check the motor-spin direction, adjust the UVW connection order, or set negative target speed in the
MCEDesigner if the direction is wrong.

15. Set the target speed to about 50% of the maximum speed and start the I, & Flx_M trace with Auto Repeat on
Level Mode (see Figure 11.) FIx_M is better within the range of 2000 to 2500 (rated value is 2048), and must
be steady and DC-like.

Some key tips for better motor-performance tuning are:

e If FIx_Mis not steady (i.e. swinging or oscillating), double check the motor parameters, speed loop
Propotional-Intergra (PI) gain, flux estimator time constant, and the setup related to the PLL PI
bandwidth (parameters PLLKp and PLLKi)

e IfFIx_Mis noisy, double check the current feedback, and the hardware and parameters related to Voc

e If FIx_Mis far from 2048, adjust the Motor Back EMF Constant (Ke) in the MCEWizard
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I8 Trace Results ? x
Iu & Fhe_M

B e ) S E— T
0 50 100 150 200 250 300 350
Sample Rate: 10kHz /(5*1 ) with Auto Repeat on Level Mode
Cursor Control Axis Control -
Min Max Scale Otfset Gnd
X Y b =0 ~ 1500

~ # Y281 AL y - +y

chiot| - 81.000 0.000 chy  )r1000 £ }1000 jo chl off)

Ch29n__‘ . 1 546.000 =} 2366.000 ch2Y ) 0 } 4000 1 =) 0 Chz Off

Apply | Apply | Reset |

Auto Repeat

Figure 11 Trace waveform for I, & FIx-M at 50% speed

16. To program a new parameter file after the firmware has been programmed, follow the instructions given in
step 9. In such cases, firmware programming is not needed and the first option—Program Parameters can
be selected.

Note: For detailed information on controller programming, refer to the Application Note AN2018-33
iMOTION™ 2.0 Device Programming, and the documentation for the MCEDesigner and MCEWizard.

2.2 Description of functional blocks

The motor inverter in the EVAL-M1-IM323 evaluation design is implemented using the CIPOS™ Tiny IPM IM323-
L6Gx, and the auxiliary power supply is based on the fixed-frequency CoolSET™ ICE5AR4770BZS.

2.2.1 Overview of IM323-L6GXx

The CIPOS™ Tiny IPM IM323 product group enables the integration of various power and control components
to increase reliability, optimize PCB size, and reduce system costs. It is designed to control 3-phase AC motors
and permanent-magnet motors in variable speed drives for applications such as air conditioners and
refrigerators.

The package concept is especially adapted to power applications that need good thermal conduction,
electrical isolation, EMI-save control, and overload protection. The integrated reverse-conducting IGBTs are
combined with an optimized silicon on insulator (SOI) gate driver for excellent electrical performance.

Figure 12 shows the internal block diagram of the CIPOS™ Tiny IPM IM323-L6Gx.
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Its main features include:

e A600Vreverse conducting, RCD2 IGBT

e Arugged SOI gate driver technology with stability against transient and negative voltage
e Anallowable negative Vs potential up to -11 V for signal transmission at Ves = 15V
e Anintegrated bootstrap functionality

e Anovercurrent shutdown mechanism

e Abuilt-in NTC thermistor for temperature monitoring

e Undervoltage lockout at all channels

e Low-side emitter pins accessible for phase current monitoring (open emitter)

e Asleep function

e Cross-conduction prevention

e Allsix switches turn off during protection

P (26)
WVs(V) )
El: (2) ve(U) Vol Hol
Rgslﬁ Va1 U (25)
(3)Vs(v)
Rcicer
(4) Vg(V) Ve2 |
Ho2 |
Res2 v (24)
(5)Vs(w) Vs2 D
El: (6) V(W) Vo3
Ho3
Res3
ves W (23)
(7) Hi (V) H
Hi2
Hi3
(10) Vo1
Voo
(11) Vss1 Ves NU (22) )
(12) Lin(U) w1
(13) Lin(V)
Ln2
(14) Liy(w) L3
NV (21)
(15) Voo Rcicer
(16) Vro Vo Lo3
(17) Irip
e
NW (20)
(18) Vss2
3
(19) Vor
Figure 12 Internal block of the IM323-L6Gx
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2.2.2 Overview of ICESAR4770BZS

The ICE5AR4770BZS is a 5™ generation, fixed-frequency integrated power IC (CoolSET™) that offers high
performance and integration with the 700 V avalanche rugged CoolMOS™ MOSFET technology controller chip
in a PG-DIP-7 package.

Figure 13 shows its internal block diagram and typical isolated flyback application.

W, L4 ’
[ l < ‘$ Con [I] Rsmarue | Snubberj ; II \MrDm —l—Cm o —I.-Cr Vor
85~ 300 VAC I Rucc  Dyce ~. +
Cvee =
! I Voz
DI‘-..DJl .
vCC GATE DRAIN
O—C {
CooMOS™
|
||-|
D. A
PWM controlier
Cument Mode Control T
Cydeby-Cyde | = Gate
current limitation Driver _@ # Rowa
Digital Control ¢
Error Amplifier
# Opticnal [T]_Active Burst Mode J Control Unit
Rsa (Burst mode detect) B Protections "
Rov (V2 feedback) ICESXRxxxxAG CoolSET

Figure 13 Internal block of ICESAR4770BZS and typical application in an isolated flyback mode

Main features of the ICE5SAR4770BZS include:

e Amaximum switching frequency of 100 kHz with a 700 V integrated MOSFET

e Power delivery of up to 15 W with a universal wide input range (85 - 300 Vac) DCM design
e Brown-in protection, fast and robust start-up operation with cascode configuration

e 3-level selectable entry/exit active-burst mode profile (optional)

e Abuilt-in digital soft start

e Cycle-by-cycle peak current limitation

e Support for both DCM and CCM operations with slope compensation

e Anintegrated error amplifier to support direct feedback, typically with non-isolated flyback topology
e Digital frequency reduction with decreased load for higher efficiency

e Frequency jitters and soft gate driving for low EMI

e Limited charging current for the Vcc pin short-to-ground

e Comprehensive protection against Vcc overvoltage, Vcc undervoltage, overload/open loop, and
overtemperature

e Auto-restart for all protection features

2.2.3 Motor external current feedback configuration and calculation

As shown in Figure 14, the current input value is a product of the shunt resistance in milliohms and the gain of
the external current-sense amplifier of the EVAL-M1-101T.
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Rsh
(mQ)

Current Input
(mV/a)

Figure 14 Current shunt feedback and sample timing for EVAL-M1-101T

The external gain-amplifier circuit can be found in the schematics or user manual for the control board (e.g.
EVAL-M1-101T.)

Figure 15 shows the Iy+ current feedback-sensing circuity on the EVAL-M1-101T evaluation board. Please note
that the default external amplification gain is less than 1 for the current-sense in this evaluation board.

+3.3V
R6 iMOTION
10k, 1% Controller
V1 R8 _ W2 6
WIOOR U

Current shunt CI15

resistor on power R7

board Zk, 1% 220pF

N 10U+
Rsh
Ish

Figure 15 Iy+ current feedback-sensing circuity on the EVAL-M1-101T evaluation board

Based on the principle of Kirchhoff's voltage law:

R7

R7 6
Vo=V~ Vpp—1 R — 1 Ry, =—Vpp+——R I
2 1 (DD sh * sh)*R6+R7 sh * Rgp R6+R7 DD R6+R7 sh * lsn
tinput = —6 g ~>p
current inpu _R6+R7 sh —6 sh

Based on this calculation, the current input for the MADK combination in EVAL-M1-101T and EVAL-M1-IM323 is
25 mV/A.
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3 System design

The EVAL-M1-IM323 board is an optimized design for 220 V small home appliances like conditioner, pump, and
fan applications. To meet individual customer requirements, and to make the EVAL-M1-IM323 evaluation
design a basis for development or modification, all board design data such as schematics, Gerber, and AD files
can be found on Infineon’s website.

3.1.1 EMI filter and soft power-up circuit

Figure 16 shows the schematic from the AC input connector X1 to the rectified DC bus voltage. This circuitry
includes a passive EMI filter consisting of elements X2, Y2 capacitors and common-mode inductor, a 35 A/800 V
rectifier bridge D1, a fuse F1 for circuit protection, a PTC resistor R1, and a relay K1 for soft powering up and
reducing conduction losses in the steady state.

X7 012200552 @(5 RI
Line ¢ X8
* EE GBJ3508-BP
Fl 044 CYl1 CY2 —| D1
. 3L R R3 Ll 2.20F 12 Tine-l T3.30F
<
. RVI k99K cx1 RV2 cx2
2 N b - == 2| XX 5
£ P L
1_EARTH X9 - - ——7""1’{“— _ pha -
m m
‘ Neutral 1uF 2.2uF L }V 74
R9 630 CY4 X11 630V
0326020.MXP/20A K99k T 2.20F Y3 3.3k <
Neutral-1
Kl
o— —o IRLML2030
RV3 T A Ql /77 /77
EARTH 5 - EARTH EARTH
8 I'LI 1 3 M2
L4 1yl
G2RL-1A-E-CV DCI2
GTI1 P _ C6 10uF
CG2470L D2 ININAI48W-7-F ”
R12
+3.3v} — RI3 — 510k
220k
(7]
X102 SGND
Ql1_Gate

Figure 16 Schematics for EMI filter and a soft power-up circuit

3.1.2 Inverter section using CIPOS™ Tiny IPM

The inverter section isimplemented using the CIPOS™ Tiny IPM as shown in Figure 17. The module includes a
combination of an optimized reverse-conducting IGBT Gen 2 (RCD2), and industry-benchmark rugged half-
bridge drivers. The shunt resistor section is also given in the inverter section, including the 0 Q resistors R46 and
R47. These resistors allow leg shunt or single shunt through different combinations. The three capacitors C7,
C13, and C15 are used as bootstrap capacitors to provide the necessary floating supply voltages VBS1, VBS2,
and VBS3 respectively.
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Figure17 Schematics for the IM323-L6Gx IPM and peripheral circuit

3.1.3

Auxiliary power supply

Figure 18 shows the schematic of the auxiliary power supply for the EVAL-M1-IM323 board. The circuit includes

the latest CoolSET™ 5

The VCC is connected to the gate drivers inside the CIPOS™ IPM.

(ICE5AR4770BZS) from Infineon and a flyback topology with direct output of 15Vand 7 V.
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Figure 18 Auxiliary power supply of the EVAL-M1-IM323
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The linear voltage regulator IFX25001ME V33 generates 3.3V from a 7V power supply VCC. The 3.3V power
supply is used in the inverter’s external overcurrent comparator circuit. Both VCC and 3.3V are also present on
the 20-pin iIMOTION™ MADK-M1 interface connector X3 to power the circuitry on the control board.

3.2 Layout

The EVAL-M1-IM323 board has two electrical layers with 140 um copper (1 oz. copper) and dimension 180 mm x

140 mm. The thickness of the PCB board is 1.6 mm. Figure 19 to 22 shows the assembly prints and layers of the
EVAL-M1-IM323.
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Figure19 Top-assembly print of the EVAL-M1-IM323
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Figure 20 Bottom-assembly print of the EVAL-M1-IM323
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Figure 22 Bottom layer of the EVAL-M1-IM323

3.3 Bill of material

The complete bill of material can be downloaded (a customer login is required) from the Download section on
the homepage of Infineon’s website.

Table 3 BOM of the most important/critical parts of the evaluation board
S. No. | Ref Designator Description Manufacturer Manufacturer P/N
1 C1,C12 CAP /FILM /470nF / 630V /10% / | Wurth Elektronik 890303426008CS
MKT (Metallized Polyester) /
-40°Ct0 85°C/22.50 mm Cx

0.80 mm W 26.00 mm L X
9.00mmTX19.00 mmH/THT /-
2 C2,C3,C4 CAP /ELCO /680 uF/450V/ Wurth Elektronik 861141486026
20% / Aluminiumelectrolytic /
-25°C to 105°C/ 10.00 mm Pitch x
35.00 mm Diax59.00 mmH/-/-
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S. No.

Ref Designator

Description

Manufacturer

Manufacturer P/N

3

C5

CAP/CERA/10uF/25V/10% /
X5R (EIA) / -55°C to 85°C /
1206(3216) / SMD / -

MuRata

GRM31CR61E106KA12

C6

CAP/CERA/10uF/16V/10% /
X5R (EIA) / -55°C to 85°C /
0805(2012) /SMD/ -

MuRata

GRM21BR61C106KE15

C7,C13,C15

CAP/CERA/10uF/25V/10% /
X7R (EIA) / -55°C to 125°C / 1206
(3216) /SMD/ -

Wurth Elektronik

885012208069

C8,C14,C16

CAP/CERA/100nF/25V/10% /
XTR (EIA) / -55°C to 125°C/
1206(3216) / SMD / -

MuRata

GRM319R71E104KA01

C9, C10

CAP/CERA/1uF/25V /5% /
XTR (EIA) / -55°C to 125°C/
1206(3216) / SMD / -

MuRata

GCM31MR71E105JA37

C11,C52

CAP /CERA/100nF/630V/
10% / X7R (EIA) / -55°C to 125°C/
1812 /SMD/ -

Wurth Elektronik

885342211006

C17,C18, C19,
C20, C21, C22

CAP/-/1nF/16V/10% /
XTR (EIA) /- /0805 /SMD /-

AVX

0805YC102K4T2A

10

C23

CAP/CERA/1nF/25V/5%/-/
-55°C to 125°C/ 0805 (2012) /
SMD /-

Wurth Elektronik

885012007040

11

C24,C46

CAP/CERA/22nF/25V /5% /
XTR (EIA) / -55°C to 125°C/
0805(2012) /SMD/ -

MuRata

GRM216R71E223JA01

12

C25

CAP/CERA/2.2nF/760V/
20% /Y5U (EIA) /-30°C to 125°C/
9.50 MM Cx0.81 mmW

10.90 mmLx5.70 mm T x
14.10mmH/-/-

Vishay

440LD22-R

13

C26

CAP/CERA/4.7TnF/100V /5% /
COG (EIA) / NP0 /-55°C to 125°C /
1206(3216) / SMD / -

MuRata

GRM3195C2A472JA01

14

C27

CAP /CERA /470 pF/630V /5% /
COG (EIA) /NP0 /-55°C to 125°C/
1206(3216) / SMD / -

MuRata

GRM31A5C2J471JW01

15

C28

CAP/ELCO /22 uF/400V/20% /
Aluminiumelectrolytic /-25°C to
105°C /5.00 mm C x 0.60 mm W
10.50 mm Diax 18.00 mmH /- /-

EHS2GM220G160T

16

C29

Chip Monolithic Ceramic
Capacitor

MuRata

GCM32D7U2J103JX01

17

C30, C31, C44,
C48

CAP /ELCO /220 uF/25V/20% /
Aluminiumelectrolytic / -40°C to

Wurth Elektronik

860020474012

25
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S. No.

Ref Designator

Description

Manufacturer

Manufacturer P/N

105°C/3.50 mm Cx 0.60 mm W
8.00 mm Diax 13.00 mmH/-/-

18

C32,C33

Chip Monolithic Ceramic
Capacitor

MuRata

GRM31CR71E106MA12

19

C34,C35

CAP/ELCO /220 uF/16V/20%/
Aluminiumelectrolytic /-40°C to
85°C/2.50 mmCx0.50 mmW
6.30 mm Diax 12.50 mmH/
THT/ -

Wurth Elektronik

860010373010

20

C36

CAP /ELCO /100 uF / 16V /20% /
Aluminiumelectrolytic /-40°C to
85°C/2.00mmCx0.50 mmW
5.00mm Diax12.50 mmH/
THT /-

Wurth Elektronik

860010372006

21

C37

CAP/CERA/100nF/16V/20% /
XTR (EIA) / -55°C to 125°C/
0805(2012) /SMD/ -

MuRata

GRM21BR71C104MAO1

22

C38

CAP /ELCO /100 uF /35V/20% /
Aluminiumelectrolytic /-40°C to
85°C/2.50 mmCx0.50 mmW
6.30 mm Diax12.50 mmH /- /-

Wurth Elektronik

860010573007

23

C39

Chip Monolithic Ceramic
Capacitor

MuRata

GRM21BR71E104KA01

24

C40, C41

Chip Monolithic Ceramic
Capacitor

MuRata

GRM216R71E102KA01

25

C42, C45, C41,
C50

CAP/CERA/220nF/25V /5% /
XTR (EIA) / -55°C to 125°C/
0805(2012) /SMD/ -

MuRata

GRM219R71E224JA01

26

C43

CAP /CERA/100nF/25V/10% /
XTR (EIA) / -55°C to 125°C/
0805(2012) / SMD / -

MuRata

GRM219R71E104KA01

27

C49

CAP/CERA/100nF/25V /5% /
XTR (EIA) / -55°C to 125°C/
0805(2012) /SMD/ -

MuRata

GRM21BR71E104JA01

28

C51

CAP/CERA/1nF/ /20%/
E (JIS) /-40°C to 125°C / 7.50 mm
Cx0.60 mmW7.00 mm L x
7.00mMmTx10.00 mmH/THT /-

MuRata

DE6E3KJ102MN3A

29

CX1

CAP/FILM/1uF/630V/10%/
MKP (Metallized Polypropylene) /
-40°Ct0 105°C/22.50 mm C x
0.80 mm W 26.00 mm L x

11.00 mm Tx20.50 mmH/-/-

Wurth Elektronik

890334026027CS

30

CX2

CAP/FILM /2.2 uF /630V/10% /
MKP (Metallized Polypropylene) /
-40°C to 105°C /22.50 mm C x

Wurth Elektronik

890334026034CS
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S. No. | Ref Designator Description Manufacturer Manufacturer P/N
0.80 mm W 26.00 mm L x
15.00mm T x25.50 mmH/-/-

31 CY1,Cv4 CAP/CERA/2.2nF/ /20%/-/- | MuRata DE6E3KJ222MN3A
40°Ct0125°C/7.50 mm Cx
0.60 mm W 9.00 mm L x7.00 mm
Tx12.00mmH/-/-

32 CY2,CY3 CAP/CERA/3.3nF/ /20%/E MuRata DE6GE3KJ332MN3A
(JIS) /-40°Cto 125°C / 7.50 mm C
x 0.60 mm W 10.00 mm L x
7.00mmTx13.00mmH/THT /-

33 D1 35 Amp Glass Passivated Bridge | Micro Commercial | GBJ3508-BP
Rectifier, 800 V Components

34 D2,D3 Surface Mount Fast Switching Diodes 1N4148W-7-F
Diode Incorporated

35 D4, D5, D6 Silicon Schottky Diode Infineon BAT60A

Technologies

36 D7,D8,D10 Surface Mount Ultrafast Rectifier | Vishay US1M-E3/61T
1.0 A/1000V

37 D9 2.0 A/100V, Surface Mount ON MBRS2H100T3G
Schottky Power Rectifier Semiconductor

38 D11,D13 Surface Mount Schottky Barrier | Vishay SS16HE3_B/H
Rectifier, 60 V

39 D12 Surface Mount Ultrafast Rectifier | Vishay US1D-E3/61T
1.0A/200V

40 F1 250 Vac/Voc, 20 A rated, Fuse with | Littelfuse 326020.MXP
ceramic body construction
permits higher interrupting
ratings and voltage ratings. Ideal
for applications where high
current loads are expected.

41 FAN1 Fan Guard, for 50 mm Fan, CUl FG50-40
40 mm pitch

42 FAN2 DC Axial Fan for omniCOOL CuI CFM-5015V-138-201
bearing system, 50 mm x 50 mm
frame. Mulitple Speed options

43 GT1 Gas Discharge Tubes - GDTs / Gas | Littelfuse CG2470L
Plasma Arrestors STANDARD
470 VNOM

44 H1 Standard Heat sink Infineon HS-5050-100

Technologies

45 K1 Relay, 1 Pole, Normally Open 3,6 | Omron G2RL-1A-E-CV DC12
to4,5,6Pins

46 L1, L2 IND/STD/7mH/15A/50%/ - Wurth Elektronik 7448061507

40°Cto0 125°C/9.5mR/THT/
Inductor, THT; 10.00 mm pitch, 4
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S. No. | Ref Designator Description Manufacturer Manufacturer P/N
pin, 27.00 mm W x 46.00 mm L x
46.00 mm H body / THT /-
47 L3, L4 IND/STD/2.2uH/2.5A/20% /- | Wurth Elektronik 744773022
40°Ct0125°C /71 mR/SMD/
Inductor, SMD; 2-Leads, 4.50 mm
Lx4 mmW x3.50 mm H body /
SMD /-
48 L5,L6 WE-CBF SMD EMI Suppression Wurth Elektronik 742792118
Ferrite Bead
49 L7 For Choke MuRata LQH55DN101M03
50 LED1 LED 3 mm Red Through Hole LiteOn LTL-1CHEE
Lamp Optoelectronics
51 LED2, LED3 WL-SMCW SMT Mono-color Chip Wurth Elektronik 150060GS75000
LED Waterclear, Green, 515 nm
52 MP1, MP2, MP3, M3 Hexagonal Threaded Spacer, | Harwin R30-1611100
MP4, MP5 Length 11 mm
53 MP7, MP8, MP9, M3 x 6 mm Pan Head, Cross Head | Duratool D00687
MP10, MP12 Metric Screw, 5.6 mm x 2.4 mm
Head, Nylon 6,6
54 Q1 30V 154 mOhm@4.5V MOSFET Infineon IRLML2030TRPbF
Technologies
55 R1 PTC thermistor for overcurrent TDK Corporation B59451C1130B070
protection and as inrush current
limiters
56 R2, R7 RES/STD/1MEG /250 mW /1% / | Vishay CRCW12061M00FK
100 ppm/K/-55°C to 155°C/
1206 /SMD / -
57 R3, R4, R8, R9 RES/STD/499k/1W/1%/ Vishay CRCW2512499KFK
100 ppm/K/-55°C to 155°C/
2512 /SMD/ -
58 R5, R42, R44 RES/STD/100k/125mW/1%/ | Vishay CRCWO0805100KFK
100 ppm/K/-55°C to 155°C/
0805/SMD/ -
59 R6 RES/STD /51k /250mW /1% / Vishay CRCW120651K0FK
100ppm/K/-55°C to 155°C/
1206 /SMD / -
60 R12 RES/STD/220k/125mW /1%/ | Vishay CRCWO0805220KFK
100 ppm/K/-55°C to 155°C/
0805/SMD/ -
61 R14, R15, R16, RES/STD/100R/125mW /1% / | Vishay CRCWO0805100RFK
R17, R18, R19, 100 ppm/K / -55°C to 155°C /
R22 0805/SMD /-
62 R20 RES/STD/4.7k/125mW /1% / | Vishay CRCWO08054K70FK

100 ppm/K/-55°C to 155°C/
0805 /SMD /-
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63 R21 RES/STD/18k/125mW /1% / Vishay CRCWO080518K0FK
100 ppm/K/-55°C to 155°C/
0805 /SMD /-

64 R23 RES/STD/1k/125mW /1% / Vishay CRCWO08051K00FK
100 ppm/K/-55°C to 155°C /
0805 /SMD/ -
65 R24 RES/STD/510R /250 mW /1% / | Vishay CRCW1206510RFK
100 ppm/K/-55°C to 155°C/
1206 /SMD /-

66 R25 RES/STD/240k /250 mW /1% / | Vishay CRCW1206240KFK
100 ppm/K /-55°C to 155°C /
1206 /SMD/ -

67 R26, R28, R30, 15M/0.25W /5% Yageo RC1206JR-0715ML
R31

68 R29 RES/STD/15k/125mW /1% / Vishay CRCWO080515KO0FK
100 ppm/K/-55°C to 155°C/
0805 /SMD /-

69 R32 Standard Thick Film Chip Vishay CRCW120610R0OFK
Resistor

70 R33, R37 RES/STD/1.5k/125mW /1% / | Vishay CRCWO08051K50FK
100 ppm/K/-55°C to 155°C/
0805 /SMD /-
71 R35, R38 RES/STD/12k/125mW /1% / | Vishay CRCWO080512K0FK
100 ppm/K/-55°C to 155°C/
0805/SMD/ -

72 R39 RES/STD/OR/-/0OR/-/-55°Cto | Vishay CRCW25120000Z0
155°C /2512 /SMD /-

73 R40 RES/STD/2.4k/125mW /1% / | Vishay CRCWO08052K40FK
100 ppm/K /-55°C to 155°C /
0805/SMD/ -
74 R41 RES/STD/2MEG /125 mW /1% / | Vishay CRCWO08052MO00FK
100 ppm/K/-55°C to 155°C/
0805 /SMD /-

75 R43 RES/STD/62k/125mW /1% / | Vishay CRCWO080562K0FK
100 ppm/K/-55°C to 155°C/
0805/SMD/ -

76 R45 RES/STD/22k/125mW /1% / Vishay CRCWO080522K0FK
100 ppm/K/-55°C to 155°C/
0805 /SMD /-

17 RS1, RS2, RS3 RES/STD/30mR/5W/1%/ Vishay WSR5R0300FEA
75 ppm/K / -65°C to 275°C / 4527
/SMD /-

78 RS4, RS5 Standard Thick Film Chip Vishay CRCW12062R40FK
Resistor
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S. No. | Ref Designator Description Manufacturer Manufacturer P/N
79 RV1, RV2, RV3, RES/STD/-/600mW/-/-/- Wurth Elektronik 820443011E
RV4 40°Cto 85°C/7.50 mm C x
0.80 mm W 16.50 mm L x
7.00mmTx20.00mmH/-/-
80 T1 Transformer, Turns Ratio (2- Wurth Elektronik 750344798
1):(9-7)-10:1, (2-1):(4-5)-5.71:1,
(2-1):(6-8)-11.43:1, Dielectric-
3000 Vac
81 U1 CIPOS Tiny IM323 Infineon IM323-L6G
Technologies
82 U2 Low Dropout Voltage Regulator, | Infineon IFX25001ME V33
3.3V Output Technologies
83 U3 Fixed Frequency 700 V CoolSET Infineon ICE5AR4TT0BZS
Technologies
84 u4 PLER, TRANSISTOR, 35V, DIP-4 Wurth Elektronik 140817140010
85 us Precision Programmable Texas Instruments | TL431CDBZR
Reference
86 ue 1.8 ADC/DC Step-Down Voltage Infineon IFX91041EJV
Regulator, Adjustable Output Technologies
Voltage
87 X1, X2 Horizontal Cable Entry Rising Wurth Elektronik 691250910003
Cage Clamp WR-TBL,3 Pins
88 X3 WR-PHD 2.54 mm Angled Dual Wurth Elektronik 613020243121
Socket Header
89 X4 Male Vertical Shrouded Header, 2 | Wurth Elektronik 62000211622
Pins, 2 mm Pitch
90 X5 Test Point THT, White Keystone 5002
Electronics Corp.
91 X6 Test Point THT, White Keystone 5002
Electronics Corp.
92 X7 Board Mount Fuse Clips for 1/4” Littelfuse 012200557
Diameter Fuses
93 X8 Test Point THT, White Keystone 5002
Electronics Corp.
94 X9 Test Point THT, White Keystone 5002
Electronics Corp.
95 X10, X29 Test Point THT, White Keystone 5002
Electronics Corp.
96 X11 Test Point THT, White Keystone 5002
Electronics Corp.
97 X12 Test Point THT, White Keystone 5002
Electronics Corp.
98 X13 Test Point THT, White Keystone 5002
Electronics Corp.
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99 X14 Test Point THT, White Keystone 5002
Electronics Corp.

100 X15 Test Point THT, White Keystone 5002
Electronics Corp.

101 X16 Test Point THT, White Keystone 5002
Electronics Corp.

102 X17 Test Point THT, White Keystone 5002
Electronics Corp.

103 X18 Test Point THT, White Keystone 5002
Electronics Corp.

104 X19 Test Point THT, White Keystone 5002
Electronics Corp.

105 X20 Test Point THT, White Keystone 5002
Electronics Corp.

106 X21 Test Point THT, White Keystone 5002
Electronics Corp.

107 X22 Test Point THT, White Keystone 5002
Electronics Corp.

108 X23 Test Point THT, White Keystone 5002
Electronics Corp.

109 X24 Test Point THT, White Keystone 5002
Electronics Corp.

110 X25 Test Point THT, White Keystone 5002
Electronics Corp.

111 X26, X28 Test Point THT, White Keystone 5002
Electronics Corp.

112 X27 Test Point THT, White Keystone 5002
Electronics Corp.

113 X30 Test Point THT, White Keystone 5002
Electronics Corp.

114 X31 Test Point THT, White Keystone 5002
Electronics Corp.

115 X32 Test Point THT, White Keystone 5002
Electronics Corp.

116 ZD1 Zener Diode with Surge Current | Vishay BZD27C22P-HE3-08

Specification
3.4 Connector details

General information on the connectors of the EVAL-M1-IM323 board’s evaluation design is provided in this
section. Table 4 lists the details of the AC-input connector.
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Table 4 AC input connector (X1)

PIN Label Function
1 E Earth ground

N AC neutral input
3 L AC line input

Table 5 lists the details of the motor UVW output connector X2.

Table5 Motor-side connector (X2)
PIN Label Function
U Connected to motor phase U
v Connected to motor phase V
3 W Connected to motor phase W

Table 6 lists the pin assignments of the 20-pin iIMOTION™ MADK-M1 interface connector X3. This connector is
the interface to the controller board.

Table 6 X3 - iMOTION™ MADK-M1 20-pin interface connector for the controller board

PIN Label Function
1 PWMUH 3.3 V-compatible logic input for high-side gate driver - Phase U
2 GND Ground
3 PWMUL 3.3 V-compatible logic input for low-side gate driver - Phase U
4 GND GND ground
5 PWMVH 3.3 V-compatible logic input for high-side gate driver - Phase V
6 +3.3V Onboard 3.3V supply
7 PWMVL 3.3 V-compatible logic input for low-side gate driver - Phase V
8 +3.3V Onboard 3.3V supply
9 PWMWH 3.3 V-compatible logic input for high-side gate driver - Phase W
10 I_U Positive current sense output
11 PWMWL 3.3 V-compatible logic input for low-side gate driver - Phase W
12 I_U- Negative current sense output or ground
13 GK Gatekill signal - active low when overcurrent is detected
14 DCBSense DC bus positive voltage, scaled in 0-3.3 V range by a voltage divider
15 VTH Thermistor output
16 I_V Not used
17 I_V- Not used
18 I_W Not used
19 I_W- Not used
20 VCC 15V power supply

3.5 Test points

Table 7 lists the assignments of the on-board test points.
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Table 7 Test points for signal measurement
PIN Label Function
X4 PWMUH 3.3 V-compatible logic input for high-side gate driver - Phase U
X5 PWMUL 3.3 V-compatible logic input for low-side gate driver - Phase U
X6 PWMVH 3.3 V-compatible logic input for high-side gate driver - Phase V
X7 PWMVL 3.3 V-compatible logic input for low-side gate driver - Phase V
X8 PWMWH 3.3 V-compatible logic input for high-side gate driver - Phase W
X9 PWMWL 3.3 V-compatible logic input for low-side gate driver - Phase W
X10 U Inverter output, motor phase U
X11 v Inverter output, motor phase V
X12 w Inverter output, motor phase W
X13 DCP DCP bus-voltage test point
X14 GND GND test point
X15 15V 15V supply
X16 3.3V 3.3Vsupply
X17 SGND SGND test point
X18 VTH Test point for temperature sensing
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4 System performance
4.1 Input voltage range test
Table 8 Tablel AcCinputvoltagerange
Specification | 165 Vac-265 Vac
Condition Typical PWM setup for a 6 kHz motor PWM, 3-phase only mode, motor speed = 1400 rpm,
Ta=29°C, Tc=90°C
Conclusion Input =1500 W, Pou: = 1500 W, and lowt = 7 Ams When input voltage is in the range of
165 t0 265 Vims
Test Data
Input voltage | Input DCBUS Input Power Output Output Test
(Vims) current (V) power factor power current waveform
(Arms) (w) (W) (Arms)
165 12.59 208 1500 0.723 1400 7.788
220 10.56 296 1455 0.630 1380 7.535 Figure 23
265 8.723 355 1445 0.632 1371 7.420
Legend CH1: lac, CH2: Vipcaus, CH3: Iy, CH4: Vac
e

......

DA IR T

ot FoAlen: LILE

Figure 23

Input voltage range and output
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4.2 Bus capacitors and Vpc ripple
Table9 Bus capacitors and Vyc ripple
Specification <10%
Condition Typical PWM setup for a 6 KHz motor PWM, 3-phase only mode, motor speed = 1400 rpm,
Ta=29°C, Tc=90°C
Conclusion Voc rippleis 2.3-5.6% (8.17 V- 11.65 V) at 1500 W run (165 Vac - 265 Vac), motor speed =
1400 rpm
Test Data
Input voltage PFC DC target (V) Ripple voltage (V) (%) Test
(Vac) waveform
165 208 23.11 5.6 Figure 24
220 296 19.55 3.3 Figure 25
265 355 16.66 2.3 Figure 26
Legend CH1: IAC, CH2: Vchus, CH3: IU, CH4: Vac
Previ M 400
4ivacy ..l,.'II|l':'lI'||='I|I\!|'|l:'lI5l!Il_\lI|lIIlll.:IIl’.I|l\lI|ll'l|ll!I|IH|liIl|.\|'|Ill|Il'l|_llII‘.IlIII|I|ll|.'i|'-l'|l||.l§||l_]| AAPEENELERA AR BRI RN LR A i! SRR LA
: R e s O A T R L N A
i
o PR AT Y2 PN AT :
A ; .‘-._\ ‘\. -._\ ‘ __‘.. '«‘\I \.I
,\‘ £-Y \ \".I \__‘ \ I '\.\ I‘".
L/ \ II.V \ o J .I\ \./'| \ I.V \ o ‘..‘
fin\ 23—\ Lk —/\L L~ L Lk /\ e
Tavac ..f, \j,r X N\/f \; [f \f L '\ /
>.)|VDCI’.'|.IS
@ 2504 @ @ 00A 4 .-:u:\' .
(@ en ey e it L l[sit poinss )| 24
| i ‘ L ¥ 4.3 [14_5«9 znz1|
|. EMS 7788 A 7.7%0 11,98m 9.259 15.85m 1244213
Figure 24 Input voltage =165V
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Figure 26 Inputvoltage=265V

4.3 Output current and PWM frequency range test

Table10  Output current and PWM range

Specification Output current is maximum 7 Anms
Condition Ta=29°C, Tc=90°C

5-20 kHz PWM

AC input voltage =220 V/50 Hz
GK0681 motor speed = 1400 rpm
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Conclusion
fpwm vs lout and Pout
6 10 15 20
8.0 1500
7.5 1300
é 70 1100 =
< 65 =
2 60 900 o
55 700
5.0 500
6 10 15 20
fowm (kHz)
e out Pout
Test Data
PWM frequency lac Pk lout Pout Tc AT Vru Vian+ Test
(kHz) (Arms) (Ams) | (W) (°c) (°c) (V) (V) waveform
5 11.09 0.617 7.731 1436 86.8 57.8 1.145 14.330
6 10.43 0.630 7.535 1381 87.7 58.7 1.142 14.366
10 9.79 0.623 7.094 1269 87.7 58.7 1.141 14.368 | Figure 27
15 9.047 0.610 6.446 1153 87.7 58.7 1.148 14.286
20 8.43 0.606 5.997 1062 87.9 58.9 1.142 14.364
Legend
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Figure 27 Output current for different PWM frequencies

4.4 Case temperature of IPM vs. output power and Vy

Specification Output power is maximum 1500 W
Condition Ta=29°C, 6 kHz PWM, AC-input voltage = 220 V/50 Hz, GK0681 motor speed = 1400 rpm
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Test Data

PWM frequency | Iac PF lout Pout Tc AT, Viu Vian+ Test
(kHz) (Arms) (Arms) (W) (°C) (°C) (V) \')] waveform

2.330 0.507 1.298 418 37.6 8.6 2.292 3.212

4.327 0.553 2.686 507 45.9 16.9 2.102 5.358

5.887 0.572 3.854 720 53.0 24.0 1.903 7.400
6 7.347 0.591 4.986 924 60.4 314 1.689 9.392

8.655 0.600 5.976 1094 68.0 39.0 1.501 11.072

9.782 0.609 6.824 1248 77.5 48.5 1.316 12.672

10.750 |0.612 7.506 1378 87.2 58.2 1.143 14.345

Legend

4.5 Heat sink thermal resistance test result

To test the thermal impedance of a heat sink to the ambient Rry(c.a), the DC source conducts the IPM’s internal
diodes, as shown in Figure 28. As the DC source voltage increases, the current through IPM l,py and the voltage
on IPM Vipy are monitored by the current and voltage meter. The IPM case-temperature test point is between
the IPM and the heat sink. It is the same as the Tc point of the inverter IGBT in the IPM datasheet.

Table 11 Table5 Heat sink temperature vs. fan voltage

Specification | Tyswax=90°C at To=25°C
Condition
Rrug-ay = Rrug-c) + Rrug-a)
THEC=A) = p tot ~ Viem X Iipm
Conclusion
Data
DC current | DCvoltage DC power |Ta Tc AT Rin Image
(A) (V) (w) (°C) (°C) (°c) (°c/w)
4.080 2.562 314 28.7 89.9 61.2 1.9
4413 2.619 34.7 29.1 90.1 61.0 0.9
4,773 2.675 38.3 29.0 89.0 60.9 0.8
4.940 2.699 40.0 29.5 90.1 60.6 0.8
5.260 2.748 43.4 30.0 90.1 60.1 0.7
5.363 2.765 445 30.9 90.4 59.5 0.7 Figure 28
5.510 2.782 46.0 30.9 90.1 59.2 0.6 Figure 29
5.597 2.798 47.0 30.5 90.5 60.0 0.6
5.767 2.842 49.2 30.6 90.4 59.8 0.6
5.803 2.831 49.3 31.0 90.7 59.7 0.6
5.887 2.853 50.4 30.4 90.6 60.2 0.6
5.927 2.862 50.9 30.2 90.0 59.8 0.6
Legend
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Figure 28 Heat sink thermal testing setup
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Figure 29 Input voltageis 15V

4.6 Auxiliary power supply

Table 12 Auxiliary power supply

Specification| 3.3V +2%, maximum 400 mA; 15V +5%, maximum 500 mA
Condition 165 -265 Vac
Conclusion |3.3Vand 15V accuracy is less than 1%
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Test Data
ACinputvoltage |3.3V Load Accuracy 15V Load Accuracy | Test
(V) (V) (mA) (%) (V) (mA) (%) waveform
3.312 0 0.4 14.92 0.5
3.309 100 0.3 14.92 0.5
3.302 200 0.1 14.92 0 0.5
3.294 300 0.2 14.92 0.5
3.288 400 0.4 14.92 0.5
165 3.317 0 0.5 14.90 0.7
3.309 100 0.3 14.90 0.7
3.300 200 0 14.91 500 0.6
3.294 300 0.2 14.91 0.6
3.288 400 0.4 14.91 0.6
3.315 0 0.5 14.92 0.5
3.309 100 0.3 14.92 0.5
3.305 200 0.2 14.92 0 0.5
3.300 300 0 14.92 0.5
220 3.286 400 0.4 14.92 0.5 Figure 30
3.317 0 0.5 14.90 0.7
3.308 100 0.2 14.90 0.7
3.302 200 0.1 14.90 500 0.7
3.294 300 0.2 14.91 0.6
3.287 400 0.4 14.90 0.7
3.315 0 0.5 14.92 0.5
3.312 100 0.4 14.92 0.5
3.303 200 0.1 14.92 0 0.5
3.296 300 0.1 14.92 0.5
265 3.289 400 0.3 14.92 0.5
3.316 0 0.5 14.91 0.6
3.311 100 0.3 14.91 0.6
3.302 200 0.1 14.90 500 0.7
3.295 300 0.2 14.91 0.6
3.286 400 0.4 14.91 0.6
Legend CH3:3.3V,CH4:15V
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Figure 30 3.3Vand 15V type waveform
4.7 Inrush current test
Table 13 Inrush current
Specification | Max. 30 Apeax
Condition e Maximum AC input voltage
e Under 30 Apeax
Conclusion | Maximum current is 21.25 Ageac Wwhen AC input voltage equals 265 V
Test Data
Ac input voltage Phase angle Max current Test waveform
(VAC) (OC) (Apeak)
0 11.45
220 90 13.91
270 13.37 .
Figure 31
0 20.996
265 90 21.25
270 20.99
Legend CH1: |AC, CH2: VAc, CH3: Vbcaus
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Figure 31 Power-off 220 V,c
4.8 Overcurrent protection (OCP)
Table 14 Motor OCP (IMC101T internal comparator)

Specification| OCP point is 20 Apeax

Condition o
e The OCP threshold is set to 21.5 Apeax

Run the motor normally and increase the torque continuously until OCP is triggered

Conclusion | Meets OCP requirement of 20 Apeax

Test Data
Operating cycle | OCP current peak value Test waveform
1 20.54 Figure 32
2 21.33 Figure 33
Legend CH1: Iy CH2: ly, CH3: GK, CH4: Vpcpus
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Figure 32 First cycle
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Figure 33 Second cycle
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4.9 Short-protection

Table 15 Motor output short-protection
Specification | Meet IPM’s 3 us short-circuit withstand time, fault-clear time is set to minimum 100 ps

Condition Run the motor and quickly short-circuit U and V phase

Conclusion | ITRIP response timeis 1.2 pus and fault-clear time is more than 100 us

Test data
Operation Phenomenon (us) Test waveform
Short U and V phase Figure 34
Trur 1.2 Figure 35
Tirree 1.68 Figure 36
Trircir >100 Figure 37
Legend CH1: Iy, CH2: Vy_phase, CH3: GK, CH4: ITRIP

e e L—:————

. 50.0 A o _@ 100V % @ S00my

Value Mean Min Miax 5td Dev |
@ Mean 2,180V  2.100 2.160 2,160 0,000 |I00us Hs.oocsrs | - o4 V|
|@ =0 6000usJ(5M points J{_
=3 T
| @ M 1350V 1.3%0 1.380 L1850 0.000 16 5ep 2021
| Max 61.00A  61.00 61,00 61,00 0000 114940 |

Figure 34 Short-protection
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Figure 36 Tirie time
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Figure 37 Trit-cLr time
4.10 Overvoltage protection (OVP)
Table 16 Overvoltage protection
Specification | Report fault at the setup OVP point
Condition Run motor and increase input voltage
Conclusion | Overvoltage triggered as expected
Test data
Operation Phenomenon Test waveform
Set the value of Question 47 - DC bus over-voltage | OV fault occurred when the bus
level in the Wizard as 360 V and run only the voltage was just over 360V, and the | Figure 38
motor, normally. Increase the Vac voltage slowly motor stopped
Legend CH1: PWMUL, CH2: VDCB, CH3: VDCBSENSE, CH4: Vac
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Figure 38 Overvoltage protection
4.11 EMC test
Table 17 EMI
Specification | Compliant with IEC standards IEC-61000-4-5
Condition Type 6 kHz PWM
Conclusion | More than 3 dB margin
Test data
Trace Frequency | Intensity | Limit Margin Note Image
(MHz) (dBuv) | (dBuv) | (dB)
2 AV 0.526 41.08 46.00 -4.92
2 AV 10.034 44,92 50.00 -5.08 . .
Line Figure 39
1 PK+ 10.238 56.31 60.00 -3.69
1 PK+ 10.854 54.55 60.00 -5.45
2AV 0.814 41.39 46.00 -4.61
1 PK+ 9.742 54.81 60.00 -5.19 Neutral Figure 40
1 PK+ 9.822 54.81 60.00 -5.19
Legend
49 Revision 1.0

2022-03-15



o~ _.
EVAL-M1-IM323 user guide Infineon
iMotionTM modular application design kit

System performance

Note: The EMI test is directly affected by the test environment and method. The results of the EM test in
this document are for reference only and not intended as the final design basis.

dBpv

0.0

150 kHz 1 MHz 10MHz 30 MHz

Figure39 Line noise

dBuv

700

10.0

0.0
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Figure 40 Neutral noise
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4,12 Surge test
Table 18 Surge
Specification IEC 61000-4-5
Class B
Condition e EVAL-M1-101T control board
o GK6063
e |M323-L6G

e Lightning surge simulator LSS-6230
e L-N2kV,L/N-PE4kV

Conclusion All pass
Test data
Pulse Basic | Connection| Waveform| Coupling | ASYNC/ Times| Pass condition | Result
voltage | voltage impedance | SYNC
(V) (Vrms) Angle
2000 220 L-N 1.2/50 us | 18 uF ASYNC 5 pass
2000 220 L-N 1.2/50 us | 18 uF SYNC0° 5 pass
2000 220 L-N 1.2/50 us | 18 uF SYNC90° |5 pass
2000 220 L-N 1.2/50 us | 18 uF SYNC 180° |5 pass
2000 220 L-N 1.2/50 us | 18 uF SYNC 270° |5 pass
2000 220 L-N 1.2/50 us | 18 uF ASYNC 5 pass
2000 220 L-N 1.2/50 us | 18 uF SYNC0° 5 pass
2000 220 L-N 1.2/50 us | 18 uF SYNC90° |5 pass
2000 220 L-N 1.2/50 us | 18 uF SYNC 180° | 5 o NoFault | oo
2000 220 L-N 1.2/50ps | 18 uF SYNC 270° |5 * L\'OO damage |-
+
4000 220 L-PE/N-PE | 1.2/50 ps iOH(F) ASYNC 5 components pass
9 uF+ o
4000 220 L-PE/N-PE | 1.2/50 ps 100 SYNCO 5 pass
9 uF+ R
4000 220 L-PE/N-PE | 1.2/50 ps 100 SYNC 90 5 pass
9 uF + o
4000 220 L-PE/N-PE | 1.2/50 ps 100 SYNC 180° |5 pass
9 uF+ o
4000 220 L-PE/N-PE | 1.2/50 ps 100 SYNC 270° |5 pass
Legend
4.13 Electrical fast transient (EFT) test
Table 19 EFT test
Specification | IEC 61000-4-4 Class B
Condition For input connector only
Conclusion | Pass
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Test data
Item Vpeak Frequency Time Result
L-N +2 kV 5/100 kHz 15/300 ms Pass
L-PE +2 kV 5/100 kHz 15/300 ms Pass
N-PE +2 kV 5/100 kHz 15/300 ms Pass
Legend
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Acronyms
Table 20 Abbreviations
Abbreviation Meaning
AC Alternating current
AD Altium designer
CAP Capacitance
CCM Continuous conduction mode
CE Conformité Européenne
CERA Ceramic
EMI Electromagnetic interference
EMC Electromagnetic compatibility
ESD Electrostatic discharge
EFT Electrical fast transient
DC Direct current
DCBUS Direct current bus voltage
DCM Discontinuous conduction mode
DCP Direct current bus voltage positive
ELCO Electrolytic capacitor
FILM Film capacitor
GUI Graphical user interface
GDT Gas discharge tube
IC Integrated circuit
IGBT Insulated gate bipolar translator
IPM Intelligent power module
LED Light emitting diode
MADK Modular application design kit
MCE Motion control engine
NTC Negative temperature coefficient
OCP Overcurrent protection
PC Personal computer
PCB Printed circuit board
PCN Process change notification
PD Product discontinuation
PE Protect earth
PGND Protect ground
PLL Phase locking loop
PTC Positive temperature coefficient
PWM Pulse-width modulation
RES, R Resistor
RMA Returned material analysis
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Abbreviation Meaning

RoHS Restriction of hazardous substances in electrical and electronic equipment
SGND Secondary ground

SOl Silicon-on-insulator

UART Universal asynchronous receiver/transmitter

USB Universal serial bus

uvw U phase/V phase/W phase

VCC Voltage circuit
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